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Introduction

€ Who Should Read This Guide
& Related Publications

¢ World Wide Web Information
¢ Cetting Help

Who Should Read This Guide

This guide is intended for administrators who are installing or configur-
ing TestPartner; it does not contain reference or usage information. You
can find that information in TestPartner Help.

Compuware assumes that you are familiar with basic Microsoft Windows
navigation. If this is not the case, familiarize yourself with the documen-
tation for Microsoft Windows before reading this guide.

Related Publications

In addition to the TestPartner Installation and Configuration Guide, the
TestPartner documentation set includes the Distributed License Manage-
ment License Installation Guide, which contains instructions for licensing
your QACenter product. Both installation guides are only available in
PDF format.

You can view and print the installation guides from your QACenter CD
or from Compuware’s FrontLine customer support Web site at http://
frontline.compuware.com

Because PDF is based on PostScript, a PostScript printer is the most
reliable way to print the installation guides. In most cases, you can also


http://frontline.compuware.com
http://frontline.compuware.com

print PDF files to PCL printers. If you cannot print the PDF files to your
printer, refer to Adobe’s Web site at http://www.adobe.com for trouble-
shooting information.

World Wide Web Information

Getting Help

To access Compuware Corporation’s site on the World Wide Web, point
your browser at http://www.compuware.com. The Compuware site
provides a variety of product and support information.

FrontLine Support Web Site: You can access online customer support for
Compuware products via the FrontLine support Web site. FrontLine
provides fast access to critical information about your QACenter product.
You can read or download documentation, frequently asked questions,
and product fixes, or e-mail your questions or comments. To access
FrontLine:

1T Open a Web browser and go to: http://frontline.compuware.com
The Welcome to FrontLine page appears.

2 On the right side of the page, enter your login ID and password and
click the Login button.

Note: If you are a first-time visitor, click the Register button to receive your
free password to access FrontLine. After you complete the registra-
tion form, your login ID and password will be e-mailed to you and
your account will be activated.

3 From the list in the center of the page, select a product and click the
Go button. You will see the product’s FrontLine home page, where
you can access documentation, technical information, fixes, and
other support items.

At Compuware, we strive to make our products and documentation the
best in the industry. Feedback from our customers helps us maintain our
quality standards. If you need support services, please obtain the follow-
ing information before calling Compuware’s 24-hour product support
hotline:

¢ The name, release (version), and build number of the QACenter prod-
uct. This information is displayed when you select the About com-
mand from your product’s Help menu. The name and release are also
on the covers of the product documentation.
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Installation information, including installed options, whether the
product uses local or network databases, whether it is installed in the
default directories, whether it is a standalone or network installation,
and whether it is a client or server installation.

Environment information, such as the operating system and release
on which the product is installed, memory, hardware/network speci-
fications, and the names and releases of other applications that were
running.

The location of the problem in the QACenter product software, and
the actions taken before the problem occurred.

The exact product error message, if any.

The exact application, licensing, or operating system error messages,
if any.

Your Compuware client, office, or site number, if available.
Compuware Customer support

Compuware Corporation
One Campus Martius
Detroit MI 48226-5099
1-800-538-7822
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Chapter 1

Getting Started

¢ Overview of QACenter
& |Installation Types
& Before Installation

Overview of QACenter

QACenter is a suite of automated software quality products for enterprise
and e-business applications. QACenter offers a comprehensive solution
for IT organizations concerned with assuring quality and performance,
while keeping pace with faster development cycles. QACenter includes:

QADirector: Coordinates the entire testing process by organizing, track-
ing, and executing automated and manual tests. QADirector integrates
with Compuware’s testing, program analysis, defect tracking, and
requirements management tools.

The QADirector Test Management Server reads job submissions from the
database, manages jobs, tracks available test execution machines, and
manages the licenses for manual test Web execution. It also reports on
the status of jobs in progress.

The QADirector Test Execution Server is installed on the local machine.
The Test Execution Server allows jobs to run on a computer, however you
do not need a Test Execution Server to run jobs via QACenter Portal.

QACenter Portal: Provides a comprehensive reporting facility that is
consistent among the QACenter point products. It enables users with
various roles and responsibilities to create and view detail, summary, and
cross-product reports. QACenter Portal ties together requirements
planning, test planning, test execution, and defect tracking to provide
users with a centralized view of application quality. It also integrates with
Reconcile and QADirector and provides QADirector Web functionality.
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QAHiperstation+: Works with mainframe QAHiperstation to test host-
based applications directly from your Windows desktop. This integrated,
workstation-based interface tool uses 32-bit code that provides improved
performance and better stability on 32-bit Windows platforms.

QARun: Tests enterprise client/server applications. QARun creates and
runs test scripts that support a wide variety of development tools and the
diverse components of today's corporate environments. QARun couples
advanced verification facilities with error-recovery mechanisms to
reliably test local and remote applications.

Reconcile: Helps create and control project requirements. It stores the
project requirements in a relational database. You can view the require-
ments through Microsoft Word, a reporting view (grid), and the Web.
Reconcile is fully integrated with QADirector and TrackRecord. Working
together, these products help you manage project development from
conception through delivery.

TestPartner: Tests Web- and Windows-based applications that use
Microsoft technologies. You can record user sessions with the applica-
tion, add validation functions, and replay the sessions later to ensure
that the application works as expected. TestPartner’s scripting language is
Visual Basic for Applications (VBA); it supports testing of Java, Visual
Basic, and Visual C++ applications; browser-based Web applications; and
COM components including both ActiveX controls and automation
objects.

TrackRecord: Records and reports information about products being
developed or supported. Information on team members, testers, sched-
ules, and defect reports is recorded in an object-oriented database; it can
be retrieved using TrackRecord's query and reporting features.
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Installation Types

Tip: An upgrade to a new
release does not require
you to uninstall the
current release provided
the current release is
TestPartner 5.3 or later.

Before you begin, determine the type of installation you need to perform:

Initial Installation: An initial installation is the first-time installation of a
product on your computer. See the installation chapter for each product
for instructions.

Modify: A modification of the product installation occurs when you add
or remove one or more of a product’s components, but not all of them.
See the maintenance chapter for instructions.

Repair: A repair installation may be necessary due to a corruption of a
program or the inadvertent deletion of the product. See the maintenance
chapter for instructions.

Remove: A remove or uninstall removes all the components of a product.
See the maintenance chapter for instructions.

Before Installation

Before installing any QACenter product, you should carefully review the
following information:

System Requirements

Review the system requirements to ensure that you meet the prerequi-
sites for the successful installation and operation of the product. System
requirements are listed in the Release Notes as well as in this book.

Release Notes

Review the Release Notes for information about new features, technical
notes, and known issues that may enhance or impact your product’s
performance. Release Notes contain recent changes that may not be
included in your QACenter product documentation.

Release Notes can be viewed from the QACenter CD or on FrontLine,
Compuware’s product support web site. The Release Notes on FrontLine
are periodically updated as new information becomes available.

To access the TestPartner Release Notes from the QACenter CD:

Chapter 1 @ Getting Started 11
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1 Insert the QACenter CD into the CD-ROM drive. If the CD browser
does not start automatically, navigate to the CD’s root directory and
run setup.exe.

2 From the main CD browser menu, click the documentation link, and
then select the TestPartner Release Notes. The Release Notes open in
your default Web browser.

3 View the Release Notes or print the document.

4  After viewing or printing the Release Notes, close the document to
return to the CD browser.

To access the TestPartner Release Notes on FrontLine:

1T Open a Web browser and go to: http://frontline.compuware.com
The Welcome to FrontLine page appears.

2 On the right side of the page, enter your login ID and password and

click the Login button.

Note: If you are a first-time visitor, click the Register button to receive your
free password to access FrontLine. After you complete the registra-
tion form, your login ID and password are e-mailed to you and your
account is activated.

3 From the list in the center of the page, select TestPartner and click
the Go button. TestPartner’s FrontLine home page appears.

4 On the left side of the TestPartner’s homepage, select the Documen-
tation link. You will see the TestPartner documentation page, which
includes links to Release Notes and other documentation types.

5 Click the HTML or PDF icons to view documents.
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Chapter 2

Installing TestPartner

L 2K R 2R N 2

*

System Requirements

Installing TestPartner

Setting Up a SQL Server or MSDE Database with TestPartner
Setting Up an Oracle Database with TestPartner

Setting Up SQL Server or Oracle for TestPartner Without a
Domain

Creating a Data Source Name

Migrating TestPartner Objects from a Standard Character Set
to UTF8 (for Unicode)

Logging On and Starting TestPartner

System Requirements

TestPartner has the following minimum system requirements:

L 2

* 6 o o

Microsoft Windows Server 2003 (formerly named .NET server 2003)
including Standard Edition (32 bit) and Enterprise Edition (32 bit),
Windows XP Professional with Service Pack 1, Service Pack 1a or Ser-
vice Pack 2, or Windows 2000 with Service Pack 4.

Mid-level Pentium III PC with 256 MB of RAM.
200 MB of available disk space.
800 x 600 or higher screen resolution.

Microsoft Visual Basic for Applications (VBA) 6.5 (6.5.1020), 6.4
(6.4.9969, 6.4.9971, or 6.4.9972), 6.3 (6.0.9108), 6.2x (6.0.8967), or
6.2 (6.0.8714). TestPartner installs VBA 6.2 (6.0.8714).
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¢ Microsoft Internet Explorer 7.0, Microsoft Internet Explorer 6.0
(SP1,SP2), Microsoft Internet Explorer 5.5 (SP2), or Microsoft Internet
Explorer 5.01 (build 5.00.3700.100, Update Versions SP4; Q822925).

¢ Microsoft SQL Server 2005, 2000 SP4, Oracle 9.2.0, 9.0.1 database on
a Microsoft platform. Oracle RDBMS on Unix\Linux platforms. For
SQL Server 2000 SP4, MDAC 2.6 SP2 (2.62.7400.1) is required for
establishing an ODBC connection. Microsoft MSDE 2.0 database can
be used for up to 5 users. TestPartner also supports Microsoft Access
2000 as a single-user database.

¢ Adobe Acrobat or Acrobat Reader (provided on the QACenter CD) to
view the documentation provided in PDF format.

¢ Additional resources may be required for testing tools and the appli-
cation under test.

Input Method Editor (IME) Support
TestPartner supports the following IMEs for the listed input systems.
Legend X = Supported

Japanese Input

System:
Windows Windows Windows
Name 2000 XP 2003
MS-IME2000 imejp.ime X X X
MS-IME2002 imjp81.ime X X
MS-IME2003 imjp9.ime X X

Korean Input System:

Windows Windows Windows

2000 XP 2003

MS-IME98 imekr98u.ime X

IME 2000 imekr61.ime X X

Simplified Chinese
Input System:
Windows Windows Windows

R 2000 XP 2003
QuanPin winpy.ime X X X
MS-PinYin98 pintlgnt.ime X X
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Windows Windows Windows

Description 2000 XP 2003
MS-PinYin 3.0 pintlgnt.ime X X
NeiMa wingb.ime X X

ZhengMa winzm.ime X X X
ShuangPin winsp.ime X X X
WuBi86 winwb86.ime X* X* X*
WuBi98 winwb98.ime X* X* X*
Enhanced Unicode  surime.ime X* X*

* Only appears with Windows XP and Windows Server 2003 with Office
XP Multilingual Support complete install.

Traditional Chinese
Input System:

Windows Windows Windows

2000 XP 2003
Alphanumeric romanime.ime X X X
Unicode unicdime.ime X X X
Quick quick.ime X X X
Phonetic phon.ime X X X
New Phonetic tintlgnt.ime X X X
New Changlie cintlgnt.ime X X X
DaYi dayi.ime X X X
Changlie chajie.ime X X X
Big5 Code winime.ime X X X
Array winar30.ime X X X

Notes: IMEs not listed above are not supported.
Text Services FrameWork (TSF) and the Rich Edit control (version 4.1
and above) are not supported for recording. This does not affect
playback.

Office 2003 IMEs are only supported for the Japanese Input System.
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Installing TestPartner
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This section explains the installation process for TestPartner. Please
review “System Requirements” on page 13 to ensure that TestPartner
installs and operates properly on your computer.

Before proceeding with the TestPartner installation, Compuware recom-
mends that you review the TestPartner Release Notes which includes
information about new features, technical notes, and known issues. The
Release Notes also document recent changes that might not be included
in TestPartner documentation. Please review this information carefully;
the Release Notes document is updated as new product information
becomes available. To review the Release Notes prior to installation, see
the “Before Installation” section of the “Getting Started” chapter.

Required: Compuware recommends that you exit all non-essential Windows

programs before running this setup program. Some Windows
programs may interfere with the installation process.

If you have a TestPartner release prior to 5.3 installed, Compuware
recommends that you back up your data and uninstall TestPartner
before installing the new version. Failure to do so may cause
problems.

You must have administrator permissions to install and use
TestPartner.

To install TestPartner:

1

Insert the QACenter CD that contains the product you want to install
into the CD-ROM drive. If the CD browser does not start automati-
cally, select the Run option from the Start menu. Click the Browse
button to navigate to the setup.exe file on the CD-ROM disk.

Select the product installation link, and then select TestPartner. The
installation wizard appears.

Read the welcome page and click Next. The License Agreement page
appears. Read the license agreement and click Yes to accept the terms
of the agreement.

If you have previously installed TestPartner 5.3 or earlier, the Infor-
mation about Database Configuration page appears. If otherwise,
the Customer Information page appears.

Type your name and company in the User Name and Organization
fields. Click Next. The Destination Folder page appears.

TestPartner Installation and Configuration Guide



6 Select a location for the TestPartner installation.

<&

By default, TestPartner installs in the folder x:\Program
Files\Compuware\TestPartner where x is the drive where Win-
dows resides on your computer.

To specify a different path, click the Browse button and select an
existing folder or type the path name in the Path field. Click OK.

7 Click Next. The Custom Setup page appears. This page allows you to
select or clear features for installation. Highlight a component to
view a brief description.

8 Select additional features to install:

Note:

If you are upgrading a release of TestPartner and have previously
installed any additonal features, you must reinstall these features to
use them with the current release.

Active Object Recognition: Lets you define support for Java con-
trols that may not be recognized by TestPartner out of the box.
The Active Object Recognition (AOR) utility includes a collection
of core Java classes and lets you add custom Helper classes and
metadata based on your application and requirements. This com-
ponent is typically used by advanced Java users.

SAP eCATT Integration: Configures TestPartner for proper inte-
gration with SAP eCATT, the online SAP testing tool for the SAP
Web Application Server 6.20. This allows for storage and retrieval
of TestPartner data from the eCATT repository and full integra-
tion for external testing from eCATT.

If you have VSTS installed on your system, the following feature is
also available:

<&

Visual Studio Integration: There are two selections for Visual
Studio Integration. Microsoft Visual Studio 2005 Team Suite must
be installed to install these features.

— Visual Studio Team Suite Integration: This option installs
TestPartner’s integration with Microsoft Visual Studio 2005
Team Suite. This integration allows you to use TestPartner as
the testing solution for Visual Studio 2005 test projects. With
the option installed, you can create TestPartner functional
test suites, run TestPartner scripts, analyze test runs, and
launch TestPartner from within Visual Studio 200S5. Note that
if selecting this feature, the Testing Tools subcomponent of
the Team Developer and Tester Tools component for Visual
Studio 2005 Team Suite must be installed to install this
feature.
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— Visual Studio Team Test Load Agent Integration: This
option installs TestPartner’s remote testing integration with
Visual Studio 2005. This integration allows TestPartner scripts
to run on remote computers through the Microsoft Visual
Studio 2005 Team Test Load Agent. Note that the Microsoft
Visual Studio 2005 Team Test Load Agent and the Visual
Studio 2005 Team Test Load Controller must be installed on
the same computer to install this feature.

Note: To start TestPartner functional testing in Visual Studio 2005 Team
Suite, start Visual Studio 2005 Team Suite after installing TestPartner
and click Project>Add New Test... or Test>New Test.... When the
Add New Test dialog box appears, select the Compuware Functional
Test template and click OK.

Make your selection(s) and click Next. The Ready to Install the
Program page appears.

9 If you want to review or change any of your installation settings,
click Back. Otherwise, click Install. The Installing Compuware
TestPartner page appears.

10 After the installation completes, you may be prompted to restart your
computer. If you are prompted to restart your computer, you can
choose to restart it now (recommended) or to restart it later.

11 Click Finish to complete the installation of TestPartner.

Performing an Unattended Installation

18

You can perform an unattended installation of TestPartner, in which
setup screen entries are made automatically from the command line. An
unattended installation can be convenient if you want to perform several
installations of TestPartner with identical configurations on different
computers from a remote location.

Note: Software distribution management software, such as Microsoft
Systems Management Server (SMS), is required to install TestPartner
remotely.

To run an unattended installation:
T Run TestPartner.msi from a command line prompt.

2 Specify the desired installation options and properties.

Note: For a complete list of options and properties, consult the Windows
Installer SDK documentation. Public properties customized for
TestPartner installation are listed later in this section.
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As an example, the command for an unattended basic installation of
TestPartner is as follows:

C:\>msiexec /i TestPartner.msi /qgn

In this example, the display option /qn is used to set the user interface
level to “none”. The user is never prompted to supply information and
never sees any messages. In addition to setting the display option, you
can also set other options, such as whether to restart a computer after
installation, display a log file, or uninstall a previous TestPartner installa-
tion. To quickly view the standard Windows Installer options, type the
following from a command line:

C:\>msiexec /i TestPartner.msi /help

TestPartner also provides customized public properties that you can use
to specify additional installation features.

Customized Public Properties for Unattended Installations
For a listing of these properties, see the following table:

Table 2-1. TestPartner Customized Public Properties for Unattended Installations

Property Description

INSTALLLEVEL Specifies installation features by level. Each feature is
assigned a value. A feature is installed only if the value
of the feature is equal or less than the INSTALLLEVEL
value.

The available TestPartner features and values are:
e Core=1

e Active_Object_Recognition = 150

e SAP_eCATT _Integration =175

e VSTS_Client_Integration = 200

¢ VSTS_Remote_Integration = 225

“Core” specifies a base installation of TestPartner.

Examples

To install Active Object Recognition in addition to
base installation features:

msiexec /i TestPartner.msi /gn
INSTALLLEVEL=150

To install all features:
msiexec /i TestPartner.msi /gn
INSTALLLEVEL=225

Chapter 2 @ Installing TestPartner 19
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Table 2-1. TestPartner Customized Public Properties for Unattended Installations

Property Description

ADDLOCAL Specifies installation features by name. Each feature is
assigned a name. A feature is installed only if its name
is specified.

The available TestPartner features listed by name are:
e Core

e Active_Obiject_Recognition

* SAP_eCATT _Integration

e VSTS_Client_Integration

e VSTS_Remote_Integration

“Core” specifies a base installation of TestPartner.

Examples

To install Active Object Recognition in addition to
base installation features:

msiexec /i TestPartner.msi /gn
ADDLOCAL”Core,
Active_Object_Recognition”

To install all features:

msiexec /i TestPartner.msi /gn
ADDLOCAL”Core,
Active_Object_Recognition,
SAP_eCATT_Integration,
VSTS_Client_Integration,
VSTS_Remote_Integration”

When using ADDLOCAL, you must always include
“Core”, in addition to any specific features.

Unsupported Windows Installer Options

For unattended installations, TestPartner does not support the following
Windows installer options:

¢ /a- Administrative installation option: This option installs a prod-
uct on the network.

¢ /j- Advertising option: This option advertises a product.

¢ /c - New instance advertising option: This option advertises a new
instance of a product.
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Where To Go Next

¢ The evaluation license supplied with your installation of TestPartner
allows you to install the product and run it for a specific period of
time without first installing a license. During this trial period, you are
informed of how much evaluation time remains.

At any time during the evaluation period, you can obtain and install
a permanent license. When the evaluation period expires, you must
obtain a license and install it before you can successfully run this
product. Refer to the License Installation Guide for instructions on
installing a license. To access this guide:

a Insert the QACenter CD into the CD-ROM drive. If the CD
browser does not automatically start, navigate to the CD’s root
directory and run setup.exe.

b From the main CD browser menu, click the licensing installation
link, and then select License Installation Guide from the sub-
menu.

¢ If Adobe Acrobat or Acrobat Reader is not installed on your com-
puter, click Install 3rd Party Software, then Install Adobe Acrobat
Reader from QACenter’s CD browser. Adobe Acrobat or Acrobat
Reader is required to view installation guides in PDF format.

¢ TestPartner automatically configures an ODBC data source when
installed using an Access Database. Before using TestPartner with
other databases, you must create and configure an ODBC data source
and an ODBC database. Continue to the following sections for
instructions:

¢ “Setting Up a SQL Server or MSDE Database with TestPartner” on
page 22
“Setting Up an Oracle Database with TestPartner” on page 31

¢ “Setting Up SQL Server or Oracle for TestPartner Without a
Domain” on page 44.

¢ After you have created and configured your database resources, you
are ready to begin using TestPartner. Refer to TestPartner Help for
more information about the tasks and activities associated with pre-
paring for, planning, building, and running test projects.
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Setting Up a SQL Server or MSDE Database with TestPartner

TestPartner accesses scripts and other assets stored in the TestPartner
database. This section describes how to set up a SQL Server or MSDE
database for use with TestPartner.

Note: Compuware recommends that a database administrator or a person
with general knowledge of database administration performs the
database setup and configuration.

SQL Server/MSDE Database Connection Requirements

Each client computer uses an ODBC data source to connect to the
database. As a result, connecting to the TestPartner database has the
following requirements:

¢ Fach computer running TestPartner must be able to access the com-
puter where the database resides.

¢ TestPartner must be installed on all computers accessing the data-
base.

¢ The database connection must be configured for use with TestPart-

ner. See “Configuring a TestPartner Database Connection” on page
60.

Creating a New SQL Server Database

22

This section describes how to create a SQL Server 2000 database using
SQL Server Enterprise Manager and a SQL Server 2005 database using SQL
Server Management Studio. In addition to the following procedures, you
must also populate the database with TestPartner tables using the
Database Maintenance utility, which is described in “Preparing the SQL
Server TestPartner Database” on page 28.

Create a SQL Server database on the server computer by following these
steps (separate instructions are provided for both SQL Server 2000 and
SQL Server 2005):
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SQL Server 2000

1 From the SQL Server Enterprise Manager, expand the navigation tree
until the Databases folder is visible.

2 Right-click the Databases folder and choose New Database. The
Database Properties window appears.
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[ aetor Wew Jods || = o (@@ X RAE R [N L Q@G Ea
Tree | Dutabecar & lamz TR
| Consoin Foct i
=] Hicrosoft 5L Servers I-._I I-_] U U U
= A 50U Server Group rivaher ez freach Mcvthernd it
=1 [Gly SHSSERVER [Winndoms BT}
= -__qmm [_l
[
2 Rencte Servws
- Support Senvices
¥ (2] Mieta Data Services
Mstart ||| 5 & %3 | [Fstn server nkerprise . B]00nment] - Maassie b | ST 1zasen

3 In the Database Properties window, enter a name for the database in
the Name field and click OK.

SQL Server 2005

1 In the Object Explorer of SQL Server Management Studio, right-click
the Databases folder and choose New Database. The New Database
window appears.

2 Enter a name for the database in the Database Name field.

3 Click OK.

Creating a New SQL Server Admin User

You need to create a SQL Server user with system administrator rights to
perform subsequent setup steps. To create a SQL Server admin user:
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SQL Server 2000

1

In SQL Server Enterprise Manager, navigate to the Security folder and
expand it. Right-click the Logins icon and choose New Login. The
SQL Server Login Properties dialog box appears.

S0L Server Login Properties - New Login

Genesal ] Server Floks | Database docas: |
©. —

1+ Windows Authentication

—

Domain
Secuiily sccess:
% Grart access

" Deny acoess

1 S0OL Serves Authenfication
Defa

Ltz
_ Specify the default language and databaze fo this bogin

master =
<Defaul» i

[ e ]

Diatahass:

Language:

Concel | Hew |

Select the General page. Enter a user ID in the Name field and select
SQL Server Authentication.

Click the Server Roles tab. Select System Administrators.

Click the Database Access tab. Select your TestPartner database and
select db_owner in the database roles list that appears below. Click
OK.

SQL Server 2005

1

In the Object Explorer of SQL Server Management Studio, navigate to
the Security folder and expand it. Right-click the Logins icon and
choose New Login. The New-Login window appears.

Select the General page. Enter a user ID in the Login name field.
Select SQL Server Authentication and enter a password. Select the
default database from the Default database drop-down list.

Select the Server Roles page. From the Server roles list, select sysad-
min.

Select the User Mapping page.

In the Map column, select the check box for the database that your

login can access. By default, the login name appears in the User col-
umn. Leave this value.
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10

In the Database role membership for list, select db_owner.
Click Ok.

In the Object Explorer, right-click the Schemas folder and choose

New Schema. Create a new schema. The new schema name must
match the name of the previously created user with system admin
rights.

Assign the system administrator as the owner of the schema.

Click OK.

Setting Up Users in SQL Server

The following procedure should be performed on the database server
computer for each user who needs to connect to the SQL Server database.

SQL Server 2000

1

2

Click Start>Programs>Microsoft SQL Server>Enterprise Manager.
The SQL Server Enterprise Manager Window appears:

"fii SOL Server Enterprise Manager - [Console RootiMicrosoft 5L Servers\5QL Server Group',5QL2000B0X (Windows N1

=loix|
| Console  window Help | =181

| acton wew 100 || & » B[m X E BB @] k(2])80mG

Tree I SQL2000BOK (Windows NT) 6 Items

6 s sovms a @m B B2 & B @&

-4 QL Server Group Databases Data Management  Replication Security Support Meta Data
HT) Transforma... Services Services

In the left pane, navigate to the database to which you would like to
add users.
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3

4

Click Tools>Wizards... or click the Run a Wizard button on the tool-
bar. This is the button with an image of a wand. The Select Wizard
dialog box appeatrs:

Select Wizard i |

Flease select the Wizard you wish to use:

- Create Database Wizard

- Create Index Wizard

- Create Login ‘Wizard

- Create Stored Procedure ‘Wizard
- Create View Wizard

|- Data Transformation Services
#- Management

2l Replication

Ok I Cancel |

Click Database and select Create Login Wizard. Click OK. The Cre-
ate Login Wizard dialog box appears.

Click Next.

Users that are set up in SQL Server can use either Windows NT or SQL
Server Authentication.

Choose an authentication method:

To use SQL Server Authentication, select the SQL Server login infor-
mation that was assigned to me by the system administrator (SQL
Server Authentication) option and click Next. The Authentication
with SQL Server panel appears.

a In the Login ID field, type the SQL Server login ID for the user
that will be used to access the SQL Server. This ID is used to
authenticate the user login credentials to the SQL Server data-
base.

b In the Password field, type the password for the user ID entered
in the Login ID field. Then retype the user’s password in the Con-
firm Password field. Click Next.

¢ Click Next. The Grant Access to Security Roles panel appears.
Click Next. The Grant Access to Databases panel appears.

Click the appropriate check boxes to select the databases to
which the user’s account is to have access. Click Next.

f Click Finish.

To use Windows NT Authentication, select the Windows account
information I use to logon to my computer (Windows authentica-
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tion) option and click Next. The Authentication With Windows
panel appears.
a Type the domain name and user ID or group name for the user or
group you would like to add
a Select the Grant access to the server option. Click Next.
Click Next again.

Select the check box for the database(s) to which the users will
have access. Click Next.

d Click Finish.

In the left pane, navigate to the database to which you added users
with the Create Login Wizard. Click Users.

In the right pane, right-click the user ID or group you added with the
wizard in the steps above and choose Properties. The Database User
Properties dialog box appears.

10 Select the db_datareader and db_datawriter check boxes. Click OK.

SQL Server 2005

1

In the Object Explorer of SQL Server Management Studio, navigate to
the Security folder and expand it. Right-click the Logins icon and
choose New Login. The New-Login window appears.

Select the General page. Enter a user ID in the Login name field.
Select either Windows Authentication or SQL Server Authentica-
tion.

Select the default database from the Default database drop-down
list.

Select the User Mapping page.

In the Map column, select the check box for the database that your
login can access. By default, the login name appears in the User col-
umn. Leave this value.

In the Default Schema column, enter the default schema. For use
with TestPartner, the default schema must match the schema of the
previously created user with system admin rights.

In the Database role membership for list, leave the default option
public checked. Select the db_datareader and db_datawriter check
boxes.

Click OK.
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9 Next, you must add the newly created user to the default schema. In
the Object Explorer of SQL Server Management Studio, navigate to
the Schemas folder, right-click the default schema (which was previ-
ously created to match the name of user with system admin rights).
Select Schema Properties.

10 Select the Permissions page.
11 Click the Add button and select a user.
12 Click OK.

Creating a New Data Source

You must create a new data source to SQL Server from the workstation
that has TestPartner installed. See “Creating a Data Source Name for a
SQL Server Database” on page 51 for detailed instructions.

Preparing the SQL Server TestPartner Database

You must prepare your new SQL Server database for use with TestPartner.
This section describes how to use the Database Maintenance utility to
populate the database with TestPartner tables.

Required: SQL Server Authentication Mode must be set to: SQL Server and
Windows (Mixed Mode) to allow connection to the SQL Server
database through the Database Maintenance utility. This setting
can be changed after any database maintenance tasks are
performed.

1 Start TestPartner’s Database Maintenance utility.

2 Click File>New Database>SQL Server. The SQL Server Data Source
Connection dialog box appears.
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SQL Server Data Source Connection E

SOL Server Data Source

Browsze... |

Owirier I Enter the user
details to connect
User D I to SGL Server.
Pazzword: I
o Enter a brief
Description: I description for
the DSM.

Create I Cancel |

3 Type the name of the new SQL Server data source or click the Browse
button and select a data source name from the Select ODBC Data
Source dialog box. Type the name of the database Owner, the SQL
Server User ID, and Password. Click the Create button.

Note: A table called TP_DSNSCHEMA must exist in the dbo schema. If the
table does not already exist in the dbo schema, a System Login
dialog box appears, requiring the password for dbo. Type the
password, and click OK. The table is created.

Only one schema can be associated with a DSN name (ODBC connec-
tion). If the chosen DSN name is already associated with a schema, a
Database Maintenance dialog box appears:

2

The DSH [TP-SOLSERVER] is associsted with schama [SCOTT]
Urdecss pou Sz the DSN, the exizhng azsociabon vl be raplaced.

e [ Reglace | Canest |

4 Click the Replace button to change the association of the DSN name
from its current schema to the new schema (users will no longer be
able to access TestPartner tables in the old schema), or click the Alias
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button to create an alias for the DSN name, a DSN Alias Creation dia-
log box appears:

DSM Alias Creation =

Enter an ahas for DEN [TP-SOLSERVER] This
alizzed DSH will be aszociated with schema
[dbea}

DSH Abas I

5 Type an alias name for the DSN, this alias will be associated with the
current schema. Click OK.

The Data Source Creation Status dialog box appears and displays the
progress of the database creation.

Log on to TestPartner

To test your setup, start TestPartner and log on. See “Logging On and
Starting TestPartner” on page 58 for instructions.
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Setting Up an Oracle Database with TestPartner

This section describes how to set up an Oracle database with TestPartner.

Note: The following instructions assume familiarity with the Oracle
database management system. Compuware recommends that a
database administrator or a person with general knowledge of
database administration performs database setup and configuration.

Oracle Database Connection Requirements

Each client computer requires a data source to connect to the database.
As a result, connecting to an Oracle database for TestPartner has the
following requirements:

¢ Each computer running TestPartner must be able to access the com-
puter where the database resides.

¢ TestPartner must be installed on all computers that access the data-
base.

¢ The appropriate database client connectivity software must be
installed on any computer that runs TestPartner.

¢ The database connection must be configured for use with TestPart-

ner. See “Configuring a TestPartner Database Connection” on page
60.

Selecting an Authentication Method

TestPartner supports the use of either Oracle OS authentication
(Windows NT) or Oracle database authentication. There are additional
installation procedures required when using Oracle OS authentication.
For a complete list of installation procedures required when using either
authentication method, refer to the appropriate subsection below.

Oracle OS Authentication

1 “Creating a New Oracle Database” on page 32

“Setting Up Oracle OS Authentication” on page 32

“Setting Up the Oracle Client” on page 33

“Preparing the Oracle Database for Client Connectivity” on page 34
“Setting Up Users for TestPartner in Oracle” on page 37

“Creating the Password Authenticated Schema” on page 41

N & L A W N

“Creating a New Data Source” on page 41
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8 “Creating the Oracle TestPartner Database” on page 41

Oracle Database Authentication

1 “Creating a New Oracle Database” on page 32

2 “Setting Up the Oracle Client” on page 33

3 “Setting Up Users for TestPartner in Oracle” on page 37

4 “Creating the Password Authenticated Schema” on page 41
5 ‘“Creating a New Data Source” on page 41

6 “Creating the Oracle TestPartner Database” on page 41

Creating a New Oracle Database

Create a new Oracle database with character set UTF8 (and National
Character Set UTFS for Oracle 8i). Consult your Oracle documentation if
creating an Oracle database is unfamiliar.

Setting Up Oracle OS Authentication

32

Note: This procedure is only necessary if using Oracle OS authentication. If
using Oracle database authentication, see “Setting Up the Oracle
Client” on page 33.

On the server where the database is located:

1 Locate the Oracle Initialization file in the directory where Oracle was
installed.

2 In the Oracle Initialization file, set values for the following parame-
ters:

Note: If any of these parameters and values do not exist, add them.
remote_Tlogin_passwordfile = none

remote_os_authent = true

T

os_authent_prefix =

3 Locate the SQLNET.ORA file in the directory where Oracle was
installed. The file should be located in ORACLE_HOME\Network\Admin
directory under the main Oracle installation directory where
ORACLE_HOME is the name assigned for the Oracle home during
installation.

4 Open SQLNET.ORA and set the value of the following parameter to
(NTS):

Note: If this parameter does not exist, add it.
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sglnet.authentication_services = (NTS)

Required: Ensure this parameter is not commented out with a # at the begin-
ning of the line.

5 Click Start>Run. The Run dialog box appears.

6 In the Open field, type regedit. Click OK. The Registry Editor dia-
log box appears.

7 In the path HKEY_LOCAL_MACHINE\SOFTWARE\ORACLE\HOMEn (where n
is the number associated with the Oracle installation), right-click
HOMEn and choose New>String Value. A new string value appears in
the right pane of the registry editor.

8 Replace the default name, New Value #1, with
OSAUTH_PREFIX_DOMATIN.

9 Double-click the string value you just created. The Edit String dialog
box appears:

Edit String (2] x

Walue name:
IDSAUTH_PHEFIX_DDMAIN

Walue data:
|TRUE

oK I Cancel |

10 In the Value data field, type TRUE. Click OK.

Setting Up the Oracle Client
On the client computer from which you will connect:

1 Locate the SQLNET.ORA file in the directory where Oracle was
installed. The file should be located in ORACLE_HOME\Network\Admin
directory under the main Oracle installation directory where
ORACLE_HOME is the name assigned for the Oracle home during
installation.

2 Open SQLNET.ORA and set the value of the
sglnet.authentication_services as follows:

Note: If this parameter does not exist, add it.
sglnet.authentication_services = (NTS)

Required: Ensure this parameter is not commented out with a # at the begin-
ning of the line.
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3 Open the TNSNAMES.ORA file in the directory where Oracle was
installed. This file should be located in ORACLE_HOME\Network\Admin
directory.

4 Copy the server’s database entry to the TNSNAMES. ORA file on the cli-
ent computer. For example:
ORACLE_SID.DOMAIN.COM=
(DESCRIPTION=
ADDRESS_LIST=
ADDRESS=(PROTOCOL=TCP) (HOST=SERVERNAME) (PORT=1521))

(

(

)
(CONNECT_DATA=
(SERVICE_NAME=ORACLE_SID)
)
)

Preparing the Oracle Database for Client Connectivity

Note: This procedure is only necessary if you are using Oracle OS authenti-
cation. If you are using Oracle database authentication, see “Setting
Up Users for TestPartner in Oracle” on page 37.

Use the following procedure to prepare an Oracle database for client
connectivity.

Note: This procedure is only necessary if you are using an Oracle client to
set up the TestPartner database.

Required: You must be logged on using an ID with administrator privileges
to perform these steps.

You must create users within a Windows NT domain. Refer to your
Microsoft Windows documentation for more information about
using a Windows domain.

These procedures are for the Windows 2000 operating system. To
set up users in another operating system, consult your Windows
documentation.

1 On the computer that has User Manager for Domains, click
Start>Settings>Control Panel.

2 Select Administrative Tools.

34 TestPartner Installation and Configuration Guide



Creating the
ORA_DBA group:

Creating Server
Access For Users

3 Select Computer Management. The Computer Management utility

window appears:

=) Computer Management

|| acion vew || ¢ = |8 | B2

Tree]

B[]

= Syskern Taols

(8- {f] Event Viewer
System Information
Performance Logs and Alerts

&) Shared Folders
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~T= -4 Local Users and Groops--.
| [ Users )
o Goups __—
= g Skorage
‘] Disk Management
@ Disk Defragmenter
-3 Logical Drives
+ ﬁ‘ Removable Storage

[-El8 Services and Apglications

B+

£

Name

B svstem Tools
Eslaage

[H8services and Applications

1|

4 In the tree view, click Local Users and Groups.

5 Click Groups.

If Oracle is installed, you should see a group named ORA_DBA. If not,
add it using the following procedure:

1 In the tree view of the Computer Management utility, right click
Groups and choose New Group. The New Group dialog box appears.

2 In the Group Name field, type ORA_DBA.

3 Click Create.
4 Click Close.

You are now ready to create server access for users.

To create individual user accounts:

1 In the tree view of the Computer Management utility, click Local

Users and Groups.
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2 Click Groups.

E Computer Management

=10 x|
J&ction Yiew |J¢'-’||X ||§
Tree I Mame | Description |
@ Computer Management: (Local) gndministrators Administrators have complete and ...
E'ﬁ% System Tools gBackup Operators Backup Operatars can override secu...
[]..@ Event Viewer gGuests Guests have the same access as me...
[]...% Syskem Information gpower Users Power Users possess most administr. ..
[]---ﬁ Performance Logs and Alerts gReplicator Supports file replication in a domain
[#-§42] Shared Folders gUsers Users are prevented From making ac...
Device Manager RA_DEA
g_vmware_ WMware User Group

EI& Skorage

----- (2] Disk Management

----- e Disk Defragmenter
=3 Logical Drives
[]--@ Removable Storage
[]--& Services and Applications

3 In the right pane, double click ORA_DBA. The ORA_DBA Properties
dialog box appears:

ORA_DBA Propetties 2| x|

General |

@ ORA_DBA

Description: ||

Members:

Add... | Bemove I
Cloze I Cancel Lpply
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4 Click the Add button. The Select Users or Groups dialog box appears:

Lookin: [ FHODO2RED =

| Name | In Folder | -
!ﬁ Everyone

@Authenticated Users —
€5 ANONYMOUS LOGON

€TEATCH

€T CREATOR OWwWNER

¢TI CREATOR GROUP

T DIALUP =

sdd | Check Names

mydomaintjeff

()3 I Cancel |

A |

5 In the Name field, browse for the user’s ID, select it, and click Add.
Or, click in the text area under the Add button and type:
domain namel\user ID
Where:
domain name: The name of the domain where the user is located.
user ID: The network ID of the user you want to give access to.

6 Click OK to save the user information and return to the ORA_DBA
Properties dialog box.

7 Repeat step 4-6 to create any additional user accounts.

8 When you are finished, click OK in the Users Properties dialog box to
return to the Computer Management utility.

Setting Up Users for TestPartner in Oracle

Note: This procedure is necessary when using either Oracle OS authentica-
tion or Oracle database authentication. Separate instructions are
provided for each type of authentication. For Oracle OS authentica-
tion, see the subsection immediately after this note. For Oracle
database authentication see the subsection, “Oracle Database
Authentication” on page 39.

Chapter 2 & Installing TestPartner 37



38

Oracle OS Authentication

Users must be created in such a way that Oracle knows they are authenti-
cated via a DOMAIN controller.

Required: When setting up users for TestPartner in Oracle, a schema must be
also created to house the actual tables in addition to the remotely
authenticated users. The schema is not domain authenticated, but
is password authenticated. See “Creating the Password Authenti-
cated Schema” on page 41 for instructions.

Users must be created within a Windows NT domain. Refer to your
Microsoft Windows documentation for more information about

using a Windows domain.

Users must be added to the ORA_DBA group.

Use SQL*Plus or SQL*Plus Worksheet to create users. If you are not famil-
iar with SQL*Plus, consult your Oracle documentation.

The user performing these steps must be a member of the ORA_DBA group
and have SYSDBA privileges. To specify users that can access the Oracle
database:

1 Start SQL*Plus or SQL*Plus Worksheet.
2 Logon as SYSTEM and connect as SYSDBA.

3 Type commands to create each user as "DOMAIN\USERNAME" IDEN-
TIFIED EXTERNALLY, and grant connection rights for each user as
"DOMAIN\USERNAME". Type DOMAIN\USERNAME in uppercase and
between double quotation marks, where DOMAIN\USERNAME is each
user’s domain and user name. For example:

SQL> create user "NT-DOMAIN\JEFF" IDENTIFIED EXTERNALLY;
SQL> grant connect, resource to "NT-DOMAIN\JEFF";

Note: SELECT_CATALOG_ROLE must also be granted to the user. For

example:

SQL> grant select_catalog_role to "NT-DOMAIN\JEFF";

Required: Microsoft operating systems return the DOMAIN\USERNAME when
the user is queried. If this does not match what is defined in the
database, NT authentication will fail with ORA-1017.

4 Grant rights to access the V_$SESSION view to individual users or to
all users as a public group.

TestPartner Installation and Configuration Guide



Remotely Granting
Access for Individual
Users

Remotely Granting
Access for All Users
(PUBLIC)

Required: All TestPartner users require rights to access the V_$SESSION view.

To grant these rights, you must be logged on as a user with admin-
istrative rights, e.g., SYSDBA.

When connecting remotely, use the server name or its alias from the
TNSNAMES . ORA file with the password.

If typing the command to remotely grant access for individual users,
type DOMAIN\USERNAME in uppercase and between double quotation
marks, where DOMAIN\USERNAME is the user name within the domain
of each user.

The following shows examples of the commands that are typed for
remotely granting access for individual users, and remotely granting
access for all users.

SQL>CONNECT SYSTEM/password@ORACLE_SID.DOMAIN.COM AS SYSDBA;
SQL>GRANT SELECT ON “V_$SESSION” TO “NT-DOMAINNJEFF”;

SQL>CONNECT SYSTEM/password@ORACLE_SID.DOMAIN.COM AS SYSDBA;
SQL>GRANT SELECT ON “V_$SESSION” TO PUBLIC;

Note: If you receive any errors that indicate you cannot grant these rights,

or that the V_$SESSION table cannot be found, you are not logged
on appropriately.

Test that Windows NT authentication is set up correctly by connect-
ing to the database via SQL*Plus. Type a "/" for the user name.
Leave the Password field blank, and enter the host string appropri-
ately. Click OK. If you are able to log on, Windows NT authentication
is working properly.

Note: In the future, you do not need to create another Oracle TestPartner

database to add users. You do not have to perform the procedures
“Creating a New Data Source” and “Creating the Oracle TestPartner
Database”.

Oracle Database Authentication

Required: When setting up users for TestPartner in Oracle, a schema must

also be created to house the actual tables in addition to the
remotely authenticated users. The schema is password authenti-
cated. See “Creating the Password Authenticated Schema” on
page 41 for instructions.

Use SQL*Plus to create users. If you are not familiar with SQL*Plus,
consult your Oracle documentation.

Chapter 2 # Installing TestPartner 39



40

The user performing these steps must be a member of the ORA_DBA group
and have SYSDBA privileges. To specify users that can access the Oracle
database:

1 Start SQL*Plus or SQL*Plus Worksheet.
2 Logon as SYSTEM and connect as SYSDBA.

3 Type commands to create each user as "USERNAME" IDENTIFIED BY
“ORACLEPASSWORD”, and grant connection rights for each user as
"USERNAME" . Type USERNAME in uppercase and between double
quotation marks, where DOMAIN\USERNAME is each user’s user name.
For example:

SQL> create user "JEFF" IDENTIFIED BY “ORACLEPASSWORD”;
SQL> grant connect, resource to "JEFF";

Note: SELECT_CATALOG_ROLE must also be granted to the user. For

example:

SQL> grant select_catalog_role to "JEFF";

4 Grant rights to access the V_$SESSION view to individual users or to
all users as a public group.

Required: All TestPartner users require rights to access the V_$SESSION view.
To grant these rights, you must be logged on as a user with admin-
istrative rights, e.g., SYSDBA.

When connecting remotely, use the server name or its alias from the
TNSNAMES . ORA file with the password.

If typing the command to remotely grant access for individual users,
type USERNAME in uppercase and between double quotation marks,
where USERNAME is the user name within the domain of each user.
For example, to remotely grant access to individual users:
SQL>CONNECT SYSTEM/password@ORACLE_SID.DOMAIN.COM AS SYSDBA;
SQL>GRANT SELECT ON “V_$SESSION” TO “JEFF”;

To remotely grant access for all users (PUBLIC)

SQL>CONNECT SYSTEM/password@ORACLE_SID.DOMAIN.COM AS SYSDBA;
SQL>GRANT SELECT ON “V_$SESSION” TO PUBLIC;

Note: If you receive any errors that indicate you cannot grant these rights,
or that the V_$SESSION table cannot be found, you are not logged
on appropriately.

In the future, you do not need to create another Oracle TestPartner
database to add users. You do not have to perform the procedures
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“Creating a New Data Source” and “Creating the Oracle TestPartner
Database”.

Creating the Password Authenticated Schema

Perform the following steps to set up the password authenticated schema
into which the TestPartner tables are stored.

Note: The password authenticated schema should not be more than five
characters in length because of Oracle character limitations in SQL
series.

1 Start SQL*Plus or SQL*Plus Worksheet if it is not started.

2 If you are not properly logged on, log on as SYSTEM and connect as
SYSDBA.

3 Type commands to create each user as "USERNAME"™ IDENTIFIED AS
"ORACLEPASSWORD", and grant connection rights for each user as
"USERNAME" . Type USERNAME in uppercase and between double
quotation marks, where USERNAME is each user’s user name. For
example:

SQL> create user "TOM" IDENTIFIED AS "ORACLEPASSWORD";
SQL> grant connect, resource to "TOM";
Creating a New Data Source

You must create a new data source to Oracle. See “Creating a Data Source
Name for an Oracle Database” on page 54 for detailed instructions.

Creating the Oracle TestPartner Database
1 Start the Database Maintenance utility.

2 Click File>sNew Database>Oracle. The Oracle Data Source Connec-
tion dialog box appears.
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Oracle Data Source Connection E

Oracle Data Source Mame :

Browsze... |

Enter the user
Schema I details to connect
to Oracle,
User ID: I
Password: |
Enter a brief
Description: I description for the
DSH.

Create I Cancel |

3 Type the name of the new Oracle data source or click the Browse but-
ton and select a data source name from the Select ODBC Data Source
dialog box. Type a User ID, Password, and a brief description of the
DSN. The Schema field is filled in automatically with the same infor-
mation as the User ID. Click the Create button.

Note: A table called TP_DSNSCHEMA must exist in the SYSTEM schema. If
the table does not already exist in the SYSTEM schema, a System
Login dialog box appears, requiring the password for SYSTEM. Type
the password, and click OK. The table is created.

Only one schema can be associated with a particular DSN name
(ODBC connection). If the chosen DSN name is already associated
with a schema, a Database Maintenance dialog box appears:

Database Mainltenance 2=l

The DSH [TPORACLER 7| is associated with schema [SCOTT]
Uiriesss wou afias e DSH, the existng association vl be eplaced.

sias | Replce | cancel |

Click the Replace button to change the association of the DSN name
from its current schema to the new schema (users will no longer be
able to access TestPartner tables in the old schema), or click the Alias
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button to create an alias for the DSN name. A DSN Alias Creation
dialog box appears:

DSK Alias Creation x|

Enber an abas fer DEN [TPORACLEET 7] This
dlizzed DSH wil be associated with schema
[dbal]

DS dbas: I

Type an alias name for the DSN, this alias will be associated with the
current schema. Click OK.

The Data Source Creation Status dialog box appears and displays the
progress of the database creation.

Log on to TestPartner

To test your setup, start TestPartner and log on. See “Logging On and
Starting TestPartner” on page 58 for instructions.
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Setting Up SQL Server or Oracle for TestPartner Without a
Domain
Note: This procedure only applies when using Windows NT authentication.

Compuware strongly recommends that you use authentication within a
domain when setting up an Oracle or SQL Server database with TestPart-
ner. However, if you are not on a domain, it is still possible to set up
these databases.

Required: To begin, you must create a user on both the client and the server
computers.

To create a user, follow these procedures:
1 Click Start>Settings>Control Panel.

2 Double-click Users and Passwords. The Users and Passwords dialog
box appears:

Users and Passwords 2| x|
Users | Advanced I

Use the list below to grant or deny users access to your
computer, and ko change passwords and other settings,

IV Users must enter a user name and password ko use this computer,

Users For this computer:

User Mame | Group |
lg_\fmware_user_ __vImware__

lg.ﬂu:lministrator Administrators

lgGuest Guests

ﬂPFHJHWD ORA_DBA; Administrators

Remove | Properties |

—Password for Administrator

g Ta change the password For Administrator, click Set

Password,
Set Password, .. |

OF | Cancel | Apply |
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3 On the Users tab, click Add. The Add New User dialog box appears:

Add New User x|

Enter the basic information For the new user,
User name: I LUSER1
Full name: I

Description: I

To continue, click Mext,

= Back I Mext = I Cancel |

4 Type a valid user name in the User name field. Click the Next but-
ton.

5 Type a valid password in both the Password and Confirm password
fields. Click the Next button.

6 Select the level of access for the user and click the Finish button.
7 On the Users and Passwords dialog box, click OK.

8 Repeat these steps on each client computer using the username and
password.

Setting Up SQL Server for TestPartner without a Domain
To set up SQL Server for TestPartner without a domain:
1 On the server computer, click Start>Settings>Control Panel.

2 Select Administrative Tools.
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3 Select Computer Management. The Computer Management utility
window appears:

E Computer Management

_{ol x|
BB @ |

Mame

mSystem Tools

System Tools @Storage

@ Event Yiewer @Services and Applications
% Syskem Information

ﬁ Performance Logs and Alerts
Shared Folders

5, Device Manager

#7 Local Users and Groups

D Users

D Groups

EI& Skorage

(L1 Disk Management

e Disk Defragmenter

=3 Logical Drives

@ Removable Storage

[]--& Services and Applications

J Action  Wiew |J = = |
Tree I

«| | i

4 In the tree view, click Local Users and Groups.

Click Groups.

E Computer Management !E[E
J Action  Wiew |J L=

Tree I | Description |
@ Computer Management (Local) gndministrators Administrators have complete and ...
E'ﬁ% System Tools gBackup Operators Backup Operatars can override secu...
[]..@ Event Yiewer gGuests Guests have the same access as me...
[]...% Syskem Information gpower Users Power Lsers possess most administr. ..
[]---ﬁ Performance Logs and Alerts gReplicator Supports file replication in a domain
-G Shared Falders Esers Users are prevented from making ac
- = Device Manager gORA DEA
i Local Users and Groups G vmware_ YMware User Group
[C Users
44 Groups
[—:I& Storage

----- (2] Disk Management

----- e Disk Defragmenter
=3 Logical Drives
[]--@ Removable Storage
[]--& Services and Applications
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6 In the right pane, double click Users. The Users Properties dialog box
appears:

Users Properties ﬂll

General |

@ Users

Description:

Members:

€ NT AUTHORITY \Authenticated Users
€T NT AUTHORITYUNTERACTIVE
€7 FRODTI\Damain Users

Add... | Eemove |

QK I Cancel | Lpply |

7  Click the Add button. The Select Users or Groups dialog box appears.

i Select Users or Groups ﬂ E

Lok ir: EFHDDMRED =

| Name | In Folder | -
!ﬁ Everyone
@Authenticated Users
€5 ANONYMOUS LOGON
€TEATCH

€T CREATOR OWwWNER
¢TI CREATOR GROUP

€TDlELUP =l

sdd | Check Names

USER1

()3 I Cancel |

pA

8 In the Name field, browse for the user’s ID, select it, and click Add.
Or, click in the text area under the Add button and type:
Luser IDIJ,
where [user ID] is the user you want to give access to.
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9 Click OK to save the user information and return to the Users Proper-
ties dialog box.

10 Repeat step 7-9 to create any additional user accounts.

11 When you are finished, click OK in the Users Properties dialog box to
return to the Computer Management utility.

12 Close the Computer Management utility.

Setting Up Oracle for TestPartner without a Domain

To set up Oracle for TestPartner without a domain, follow the procedures
for “Creating Server Access For Users” on page 35 with the following
exceptions:

Substitute the user name you created under, “Setting Up SQL Server or
Oracle for TestPartner Without a Domain” on page 44 as shown in step 1
below:

Figure 2-1. Select Users or Groups Dialog Box

i Select Users or Groups ﬂ E

Lok ir: EFHDDMRED =

| Name | In Folder | -
!ﬁ Everyone
@Authenticated Users
€5 ANONYMOUS LOGON
€TEATCH

€T CREATOR OWwWNER
¢TI CREATOR GROUP

€TDlELUP =l

sdd | Check Names

USER1

()3 I Cancel |
#

1 Click in the text area under the Add button (Figure 2-1) and type
Luser name] instead of [domain name]\[user ID] or [domain
name] \ [group name].

In addition, when using SQL*Plus to create users (see step 3 on page 38),
substitute COMPUTERNAME\ USERNAME for DOMAIN\USERNAME as shown
below:
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Granting Access for
Individual Users

Granting Access for All
Users (PUBLIC)

2 Create the user as "[COMPUTERNAMEJ\USERNAME" IDENTIFIED EXTER-

NALLY, entering the COMPUTERNAME\ USERNAME in uppercase and
between "' like the following example:

SQL> create user "FHOOOZRED\USER1"™ IDENTIFIED EXTERNALLY;
SQL> grant connect, resource to "FHOOO2RED\USER1";

Click Start>Programs>Compuware>TestPartner>Utilities>Data-
base Maintenance.

Grant rights to access the V_$SESSION view to individual users or to
all users as a public group.
Open Oracle’s SQL*Plus Worksheet. Login as SYSTEM and connect as

SYSDBA. You can grant the access rights by entering the commands
shown below.

Required: All TestPartner users require rights to access the V_$SESSION view.

To grant these rights, you must be logged on as a user with admin-
istrative rights, e.g., SYSDBA.

SQL>CONNECT SYSTEM/password AS SYSDBA;
SQL>GRANT SELECT ON “V_$SESSION” TO “COMPUTER NAMENJEFF”;

SQL>CONNECT SYSTEM/password AS SYSDBA;
SQL>GRANT SELECT ON “V_$SESSION” TO PUBLIC;

Note: If you receive any errors that indicate you cannot grant these rights,

or that the V_$SESSION table cannot be found, you are not logged
on appropriately.
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Creating a Data Source Name

On each computer that is connecting to the TestPartner SQL Server,
MSDE, Access or Oracle database, you must create a data source name
(DSN) using the ODBC utility.

The ODBC utility can be accessed from the Windows Control Panel.

Required: These procedures are for the Windows 2000 operating system. To
set up users in another operating system, consult your Windows
documentation.

Creating a Data Source Name for an Access Database

50

On each client computer connecting to an Access database, perform the
following steps to set up a DSN:

1 Click Start>Settings>Control Panel>Administrative Tools>Data
Sources (ODBC). The ODBC Data Source Administrator dialog box
appears.

2 Click the System DSN tab, then click the Add button. The Create
New Data Source dialog box appears:

Create New Data Source ﬂ

Select a driver for which pou want to zet up a data source.

Mame | W -
Diriver da Microzoft para arquivos testo [k=t; *csv) 4.
Diriver do Microzoft Access [*.mdb)
Diriver do Microzoft dB aze [*.dbf)
Diriver do Microzoft Excel[* =1z
Diriver do Microzoft Paradox [*.db ]

Driver para o Micresoft Yisual FoxPro
iMicrozoft Access Dinver [*.mdb] §
Microzoft Access-Treiber [ mdb)
Microzoft dB aze Driver [*.dbf]

hdimroemft AR zea WEP Dirivar (% ARF
4 I I

s BN NN

Tn.
4

< Back I Finizh I Cancel |

This dialog box lists the available ODBC drivers.

3  From the list of drivers, select the Microsoft Access Driver and click
the Finish button. The ODBC Microsoft Access Setup dialog box
appears.

4 In the Data Source Name field, type the data source name. Since this
name appears as the database name in TestPartner’s logon screen, it is
recommended you enter a logical name in this field.
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5 In the Description field, type a description for the data source. For
example, Connection to TestPartner Access database.

6 Click the Select button and browse for your Access database.
7 On the ODBC Microsoft Access Setup dialog box, click OK.
8 Click OK on the ODBC Administrator dialog box.

Creating a Data Source Name for a SQL Server Database
On each client computer, perform the following steps to set up a DSN:

1 Click Start>Settings>Control Panel>Administrative Tools>Data
Sources (ODBC). The ODBC Data Source Administrator dialog box
appears.

2 Click the System DSN tab, then click the Add button. The Create
New Data Source dialog box appears:

Create New Data Source ﬂ
Select a driver for which pou want to zet up a data source.
Mame | W ;I

Microsoft ODBLC for Oracle
Microzoft Paradox Driver [*.db ]
Microzoft Parados-Treiber [*.db ]
Microzoft Test Driver [*.tat; * cav]

2
4.
4.
4.
Microzoft Test-Treiber (% tat; * cav] 4,
Microsoft Visual FoxPro Driver E.
Microsoft Visual FouPro-Treiber E.
g
2

Dracle ODBC Driver

< Back I Finizh I Cancel |

This dialog box lists the available ODBC drivers.

3 From the list of drivers, select SQL Server and click the Finish but-
ton. The Create a New Data Source to SQL Server dialog box appears.

4 In the Name field, enter the data source name. Since this name
appears as the database name in TestPartner’s logon screen, it is rec-
ommended you enter a logical name in this field.

5 In the Description field, enter a description for the data source. For
example, Connection to TestPartner SQL database.

6 In the Server field, enter the server name or select it from the drop-
down list. If you do not know the server name, consult your database
administrator.
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7

10

11
12

Click the Next button. The Create a New Data Source to SQL Server
dialog box appears.

Do one of the following:

<& If user(s) using the DSN to access the SQL Server database are con-
necting with native authentication, select the With SQL Server
authentication using a login ID and password entered by the
user option.
Make sure the Connect to SQL Server to obtain the default
settings for the additional configuration options check box is
selected.

Type the users native SQL Server logon credentials in the Login
ID and Password fields.

or
<& If user(s) using the DSN to access the SQL Server database are con-

necting with non-native credentials, select the With Windows
NT authentication using the network login ID option.

Click the Client Configuration button. The Add Network Library
Configuration dialog box appears:

Add Network Library Configuration ﬂ
Server alias: ISQL2DDDBox
— Metwork libraries———— [~ Connection p
e s Server name: ISQL2UUUBDH
&+ TCRAP
 Multipratacal v Dynamically determine port
© NwiLink IPR/SPR Part humber: |1433
" &ppleTalk
" Banyan ¥INES
WA
" Other
0k I Cancel | Help |

Ensure that the appropriate network library protocol is selected. If
necessary, consult your network administrator to verify the correct
network protocol.

Click OK to exit. You are returned to the Create a New Data Source to
SQL Server dialog box.

Click Next.

Select the Change the default database to check box, then select
your TestPartner database name from the drop-down list.
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13 Accept all the other entries and click the Next button until the last
panel in the wizard appears.

14 Accept the defaults and click the Finish button. The ODBC Microsoft
SQL Server Setup window appears.

Testing the Connection

Once the connection to the database is established, use the following
procedure to test the connection:

1 In the ODBC Microsoft SQL Server Setup window, click the Test Data
Source button. You should see the following:

SOL Server ODBC Data Source Tesk X

 Test Result

Microsoft SOL Server ODBC Driver Version 03.80.0380 ;I
Running connectivity tests. .

Attempting connection

Connection established

erifying option settings

Dizconnecting from server

TESTS COMPLETED SUCCESSFULLY!

2 Click OK. The ODBC Microsoft SQL Server Setup window displays.
Note: If your test results fail, you need to check your setup steps again.

3 Click OK. The ODBC Data Source Administrator window displays.
The newly created data source appears in the System Data Sources
list.

4 Click OK to close the ODBC utility.
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Creating a Data Source Name for an MSDE Database
Follow the same steps under “Creating a Data Source Name for a SQL
Server Database” on page 51, with the following exceptions:
¢ In step 3, select (local) for the server name.

Figure 2-2. Create a New Data Source to SQL Server

Create a New Data Source to S0L Server il

Thiz wizard will help you create an ODBL data source that you can use to
connect to SOL Server.

‘what name do you want to use to refer to the data source?

MName: [MyMSDE

How do you want to describe the data source?

Description: I

‘whhich SOL Server do you want to connect to?

Server: IE j

Finizh I Mest » | Cancel | Help |

¢ In step 6, a list of databases will be available for selection. However,
only the default databases from the MSDE installation will appear in
the drop-down list. If you wish to create your own database for
MSDE, you must use a front-end interface such as Enterprise Man-
ager.

Creating a Data Source Name for an Oracle Database

On each client computer connecting to an Oracle database, perform the
following steps to set up a DSN:

1 Click Start>Settings>Control Panel>Administrative Tools>Data
Sources (ODBC). The ODBC Data Source Administrator dialog box
appears.
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2 Click the System DSN tab, then click the Add button. The Create
New Data Source dialog box appears:

Create New Data Source il

Select a driver for which you want to set up a data source.

I ame | W ;l
Microzoft ODEC for Oracle
Microzoft Paradox Diniver [*.db )
Microzoft Paradox-Treiber [*.db |
Microzoft Text Diriver [* st * cav)
Microzoft Text-Treiber [* tat; * cav)
Microzoft Yisual FouPro Driver
Microgoft Yisual FosPro-Treiber
Oracle in OraHaormeS0

SOL Sereer

KN

b0 m M ope e e e D

-

< Back I Finish I Cancel |

3 From the list of drivers, select the Oracle in OraHome90 (not the
Microsoft ODBC for Oracle driver) and click the Finish button.

The Oracle ODBC Driver Configuration dialog box appears. The
following shows this dialog box for Oracle 9.0.1.

Oracle ODBC Driver Configuration

Data Source Mame IDrac:Ie 9

© |
Dezcription I &l

Hel
TS Service Mame IG"°‘1—E-‘°"\"|S j 4p|
I Test Connection |

Uszer 1D

Applicatiot I Draclel ‘wiarkarounds I SOLS erver Migration I Transzlation Options I

Enable Result Sets ¥ Enable Quern Timeout v Flead-Only Conmection [

Enable Closing Cursars I Enable Thiead Safety v SOLGetData Extensions |

Batch Autocommit Mode I Cornrit anly if all statements succesd j

4 In the Data Source Name field, type the data source name. Since this
name appears as the database name in TestPartner’s logon screen, it is
recommended you enter a logical name in this field.

5 In the Description field, type a description for the data source. For
example, Connection to TestPartner Oracle database.
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6 In the TNS Service Name field, select the service name for the data-
base you would like to connect to in the format
ORACLE_SID.DOMAIN, where ORACLE_SID is the Oracle SID you
assigned to the database upon creation and domain is the domain
that you are connecting to.

7 If you are creating a Data Source name for an Oracle 9.0.1 database,
test the connection. See “Testing the Connection” below. Otherwise,
click OK.

Testing the Connection

1T On the Oracle ODBC Driver Configuration dialog box, click the Test
Connection button.

Note: When using Oracle database authentication, type a username, and
then a password. For Oracle OS authentication, do not specify a
username.

A message box appears stating the connection was successful.

2 Click OK to close the message box. The Data Source name creation is
complete.
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Migrating TestPartner Objects from a Standard Character Set to
UTF8 (for Unicode)

Compuware recommends that an Oracle DBA or someone familiar with
Oracle export and import utilities perform the following task. For
databases larger than 2GB, the DBA should select appropriate parameters
based on the size of the database.

Oracle databases for TestPartner releases 05.03 and later require a UTF8
character set. In order to support a TestPartner database previously
created in an Oracle instance with a standard character set, the database
must be exported from the standard database and imported into an
Oracle instance created with a UTF8 character set.

Caution: If the schema from which the TestPartner objects are being
exported contains more than just TestPartner objects, it is recommended
(required if the schema is SYSTEM) that the TestPartner objects be transferred
to a new schema using the TestPartner Database Maintenance Utility
05.02.00 (or older) Oracle-to-Oracle Copy Utility. The objects can be then
exported from the new schema.

To perform the migration:

1 Start a command prompt and change the directory to $ORACLE_HOME/
bin. This directory should contain both exp.exe and imp.exe.
Exp.exe will be used to perform the export, imp.exe will be used to
perform the import.

Caution: Before exporting, be sure there is sufficient disk space. If there
is not enough space, export will end in a write failure.

2 Type SET ORACLE_SID=MYSID into the command prompt, where
MYSID is the SID of the Oracle instance, and press Enter.

3 Type EXP USERNAME/PASSWORD FILE=EXPORT.DMP
LOG=EXPORT.LOG CONSISTENT=Y into the command prompt,
where USERNAME is the name of the schema to export and PASSWORD
is the password for the schema. Press Enter to start the export.

Note: To perform the export without knowing the user’s password, instead
execute it as the system user. Type EXP SYSTEM/PASSWORD
FILE=EXPORT.DMP LOG=EXPORT.LOG CONSISTENT=Y
OWNER=USERI into the command prompt, where PASSWORD in the
system user password and USERI is the owner of the schema to
export.
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4 Create a new Oracle database with character set UTF8 (and National
Character Set UTFS for Oracle 8i). Consult your Oracle documenta-
tion if creating an Oracle database is unfamiliar.

5 Create a new user in the new Oracle instance and grant them CON-
NECT, RESOURCE, and SELECT_CATALOG_ROLES privileges.

6 Click Start>Programs>Compuware>TestPartner>Utilities>Data-
base Maintenance from the Windows Start menu to start the
TestPartner Database Maintenance Utility.

7 Click Tools>Create UTF8 Migration Database, the Oracle Data
source Connection dialog displays.

8 Browse to the new Oracle instance with the UTFS8 character set for
the Oracle Data Source Name field and fill in the User ID and Pass-
word fields with the new schema (the Description field is optional).
Click OK (steps identical to the steps in Creating the Oracle TestPart-
ner Database may have to be followed in order to complete this step).

9 Return to the command prompt and type SET ORACLE_SID=MYSID,
where MYSID is the SID of the UTF8 Oracle instance, and press Enter.

10 Type IMP USERNAME/PASSWORD FILE=EXPORT.DMP
LOG=IMPORT.LOG IGNORE=Y into the command prompt, where
USERNAME is the name of the schema to import into and PASS-
WORD is the password for the schema. Press Enter to start the
import.

Note: To perform the import without knowing the user’s password, instead
execute it as the system user. Type IMP SYSTEM/PASSWORD
FILE=EXPORT.DMP LOG=IMPORT.LOG FROMUSER=USER1
TOUSER=USER1 IGNORE=Y into the command prompt, where
PASSWORD in the system user password and USERI is the owner of
the schema that was exported and FROMUSER and TOUSER are
identical.

Logging On and Starting TestPartner

Use the following procedure to launch TestPartner and log on to TestPart-
ner.
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1 Start TestPartner by clicking the taskbar’s Start button, then choose
Programs>Compuware>TestPartner>TestPartner. The TestPartner
splash screen appears, followed by the TestPartner Logon dialog box.

TestParther Logon

TestPartner’

from Compuware

U=ser Mame: I Adrmin

Basswiard: I |

Catabase: ITestF‘artner ;!

| Configure. .. I | (] 4 I Cancel |

2 Type a user name in the User Name field and type a password in the
Password field.

If using TestPartner for the first time, an administrative User Name
and password may be required. The default user name is Admin and
the default password is admin. Change this password after logon to
prevent unauthorized access.

3 Select the TestPartner database to work with from the Database list.
TestPartner’s testing assets are stored in a test asset repository, or data-
base, which offers centralized control of users and system access
rights under password control.

For a database to appear in the Database list, you must first configure
its database connection for use with TestPartner. To configure a data-
base connection, click the Configure button on the TestPartner
Logon dialog box. See “Configuring a TestPartner Database Connec-
tion” on page 60.

Note: Clicking the Cancel button while logging on exits the TestPartner

application. This is because TestPartner requires attaching to a
database during startup.

4 Click OK to log on.
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The TestPartner Welcome dialog box appears. This dialog box guides
entry into the TestPartner desktop. It appears after the first successful
logon.

Figure 2-3. TestPartner Welcome Dialog Box

Welcome

TestPartner’

from Compuware”

Record a Script Using:

The Code \Window.
Record, write and modify scripts directly in
Microsoft® Yisual Basic@® for Applications

The %isual Mavigaton
Quickly record, design and build tests using a
visuzl representation of script camponents

Bun the Tutorial
Learn about and interactively Tl
explore TestPariner features i

Project and User Management

COnlite Documentation

[ Do not show this dialog in the future

TestPartner may be configured so that this screen does not appear
during future access. See “Setting TestPartner Options” in TestPartner
Help.

¢ Display scripts using the Visual Navigator window or the VBA Code
window, run the tutorial, or view the documentation from the
TestPartner Welcome dialog box.

¢ Choose The Visual Navigator or The Code Window option to open
TestPartner’s desktop. The Select Project dialog box appears. Because
TestPartner automatically opens a new script each time it starts, and
prompts to select a project. For information about administering
users and adding projects, see TestPartner Help.

Configuring a TestPartner Database Connection
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Before you can use a database with TestPartner, you must configure its
database connection. The configuration process consists of using the
Configure Data Source dialog box to perform the following tasks:

¢ Specify the database connection data required to initiate the database
connection
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¢ Verify the connection to the database

¢ Save the database connection data

All configured database connections appear in the Database list on the

TestPartner Logon dialog box.

You can also use the Configure Data Source dialog box to view, edit, and
remove any existing configured database connections.

Use the following procedure to configure a TestPartner database connec-

tion.

1 Click the Configure button on the TestPartner Logon dialog box.

The Configure Data Source dialog box appears.

Figure 2-4. TestPartner’s Configure Data Source Dialog Box

Configure Data Source

—[Daka Source Information

[Daka Source Type:

Select Data Source:

Descripkion:

" Access " oracle % 501 Serverf MSDE

|LocaL |

¥ Use as a TestPartner database

—[Database Settings

Database: | TESTPARTMER.
Cwner: | TP_OWHER
Authentication
T Iser Mame: IUSEFOHE
{* Database Password: I*****
Help | Apply | walidate Close

]|

2 In the Data Source Type field, select the type of data source.
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From the Select Data Source list, select from the list of available
DSN.

Select the Use as a TestPartner database check box to add the
selected DSN to the list of configured database connections that
appear in the Database list on TestPartner Logon dialog box. You
must select this check box when configuring a database connection
for the first time.

Note: For existing configured database connections, clearing the Use as a

TestPartner database check box and clicking the Apply button
removes the selected DSN from the Database list on the TestPartner
Logon dialog box. TestPartner does not retain the associated
database connection data.

Under Database Settings, specify the appropriate information for the
selected DSN. The Database/Server and Owner/Schema fields func-
tion differently depending on the selected data source type.

a For Access, the Database field is read-only and displays the loca-
tion of the database file. This value is read directly from the
ODBC DSN. The other Database Settings fields are not applica-
ble for Access and are disabled.

b For Oracle, the Server field is read-only and displays only the
database name. This value is read directly from the ODBC DSN.
In the Schema field, type the appropriate value.

c¢ For SQL Server, the Database field is modifiable and allows you
to type the appropriate database name. In the Owner field, type
the appropriate value.

The Authentication field determines the method of authentication
being used and only applies to Oracle or SQL Server/MSDE databases.
You can choose to either use Windows NT authentication or authen-
ticate using the database’s native authentication capabilities. When
selecting database authentication, you must provide the user name
and password in the appropriate fields.

Click Validate to verify that you can connect to the database using
the specified database connection data.

Click Apply to save the database connection data.
Click Close.
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Chapter 3
Maintaining the Installation

# Accessing Maintenance Mode
4 Modifying an Installation

4 Repairing an Installation

4 Removing a Product

Accessing Maintenance Mode

Required: Compuware recommends that you exit all non-essential Windows
programs before running this setup program. Some Windows
programs may interfere with the installation process.

To access Maintenance Mode from the Windows Control Panel:

1 Click the Windows Start button and choose Settings>Control Panel.
The Control Panel window appears.

2 (Click the Add/Remove Programs icon. The Add/Remove Programs
dialog box appears. Select Compuware TestPartner and click the
Change button or Remove button.

You are presented with the three maintenance mode options: Modify,
Repair, and Remove. For more information about these options, see the
appropriate section in this chapter.

Modifying an Installation

Rather than uninstall and re-install the product, you can modify a
TestPartner installation by adding or removing an optional component.
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Modifying Products With Optional Components

1

Access maintenance mode using the method described at the begin-
ning of this chapter.

Select the Modify option. Click Next. The Select Components dialog
box appears allowing you to add or remove components.

Click Next. Setup will add or remove the appropriate components.

After modifying, you may be prompted to restart your computer. If
you are prompted to restart your computer, you may choose to restart
it now (recommended) or to restart it later.

Click Finish to complete the maintenance.

Repairing an Installation

There may be times when you need to repair a damaged TestPartner
installation. This could be due to an inadvertent deletion or corruption
of the program. To repair a TestPartner installation, follow these steps:

1

Access maintenance mode using the method described in “Accessing
Maintenance Mode” at the beginning of this chapter.

Select the Repair option. Click Next. Setup will repair the TestPartner
installation.

After repairing, you may be prompted to restart your computer. If
you are prompted to restart the computer, you may choose to restart
it now (recommended) or to restart it later.

Click Finish to complete the maintenance.

Removing a Product

64

If you want to remove TestPartner installation from your computer:

1

Access maintenance mode using the method described at the begin-
ning of this chapter.

Select the Remove option. Click Next. The Confirm File Deletion
dialog box appears.

Click OK. Setup will remove the TestPartner installation. You have
the option to either save or delete the TestPartner database. Do not
delete it if you need to retain the data in the database, as in the case
of a product upgrade.
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After uninstalling, you may be prompted to restart your computer. If
you are prompted to restart your computer, you may choose to restart
it now (recommended) or to restart it later.

Click Finish to complete the maintenance.
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